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 Application of HEC-RAS to Culvert Hydraulics 
 
I.  Introduction 
 
 Objectives: 
 
 - To Know the required data for the HEC-RAS Culvert routines.   
 
 -  To become familiar with how to enter the culvert data through the use of 

the HEC-RAS user interface. 
 
 -  To become familiar with the available output that is specific to culverts. 
 
 References: 
 
  FHWA, 1985.  Hydraulics Design of Highway Culverts, HDS No. 5, U.S. 

Department of Transportation, September 1985, Washington, D.C. 
 
  HEC, 1995.  HEC-RAS User’s Manual, Chapter 6, Hydrologic Engineering 

Center, July 1995. 
   
 

HEC-RAS computes energy losses caused by structures such as culverts in 
three parts (Figure 1): 

 
 1. The losses that occur in the reach immediately downstream from the 

structure (cross sections 1-2), where an expansion of flow takes place. 
 
 2. The losses through the structure itself (cross sections 2-3). 
 
 3. The losses that occur in the reach immediately upstream of the structure 

(cross sections 3-4), where the flow is contracting towards the opening. 
 

The culvert hydraulic computations in HEC-RAS are similar to the bridge 
hydraulic computations, except the Federal Highway Administration's (FHWA, 
1985) standard equations for culvert hydraulics under inlet control are used to 
compute the losses through the structure.  Because of the similarities between 
culverts and other types of bridges, the cross section layout, the use of 
ineffective areas, the selection of contraction and expansion coefficients, and 
many other aspects of bridge analysis apply to culverts as well. 

 
The culvert routines in HEC-RAS have the ability to model nine different types of 
culvert shapes.  These shapes include box (rectangular), circular, elliptical, arch, 
pipe arch, semi circular, low arch, high arch, and Conspan culverts.  
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Figure 1.  Cross Section Layout for Culvert Modeling 

 
 

II.  Entering and Editing Culvert Data 
 

Culvert data are entered in the same manner as bridge data.  To enter culvert 
data the user presses the Bridge/Culvert button on the Geometric Data window.  
Once this button is pressed, the Bridge/Culvert Data Editor will appear (Figure 2).   

 
 
 



L-1618/2007/Brunner/Jensen 3 

 
Figure 2.  Bridge/Culvert Data Editor 

 
To add a culvert group to the model the user must then do the following: 

 
 1. Select the river and reach that you would like to place the culvert in.  This 

is accomplished by pressing the down arrow on the reach box, and then 
selecting the reach of choice. 

 
 2. Go to the Options menu of the Bridge/Culvert editor and select Add a 

Bridge and/or Culvert from the list.  An input box will appear prompting 
you to enter a river station identifier for the new culvert group.  After 
entering the river station, press the OK button and the cross sections that 
bound the new culvert group will appear in the editor. 
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 3. Enter all of the required data for the culvert group.  This includes the 

culvert deck information and the culvert specific data.  The culvert deck 
and roadway information is entered in the same manner as a bridge (using 
the deck/roadway editor).  To enter culvert specific data, press the Culvert 
button on the Bridge/Culvert Data editor. 

 
 4. Once all of the culvert data are entered, press the OK button in order for 

the interface to accept the information. 
 

River, Reach and River Station.  The River box is used to select the river for 
the culvert from the available rivers setup in the schematic diagram.  The Reach 
box allows the user to select a reach within the selected river.  The river and 
reach label defines which reach the culvert will be located in.  The River Station 
tag defines where the culvert will be located within the specified reach.  The 
River Station tag does not have to be the actual river station of the culvert, but it 
must be a numeric value.  The River Station tag for the culvert should be 
numerically between the two cross sections that bound the culvert.  Once the 
user selects Add a Bridge and/or Culvert from the options menu, an input box 
will appear prompting you to enter a River Station tag for the new culvert.  After 
the River Station tag is entered, the two cross sections that bound the culvert will 
be displayed on the editor. 
 
Description.  The description box is used to describe the culvert location in more 
detail than just the reach and river station.  This box has a limit of 256 characters.  
Only the first line of information is displayed, unless the button to the right of the 
box is pressed.  Also, the first 40 characters of the description are used as a 
label for culvert plots and tables. 
 
Culvert Deck.  The culvert deck is virtually the same as the bridge deck/roadway 
information.  The deck is used to describe the area blocking the stream and the 
roadway profile.  The only difference in the deck information for culverts is that 
the low chord elevations should be left blank or set to elevations below the 
ground data.  This will cause the deck to completely fill the channel up to the 
roadway elevations (high chord data).  Therefore, the only opening below the 
roadway will be what ever culvert openings are entered.  To enter the culvert 
deck information, press the Deck/Roadway button on the Bridge/Culvert Data 
Editor window.  
 
Culvert Data.  To enter culvert specific information, press the Culvert button on 
the Bridge/Culvert Data Editor window.  When this button is pressed, the Culvert 
Data Editor will appear as shown in Figure 3.  

 
The information entered in the Culvert Data Editor consists of the following: 
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Culvert ID# -  The culvert identifier (ID#) is automatically assigned to "Culvert #1" 
the first time you open the editor.  The user can enter more than one culvert type 
if they are working on a multiple culvert opening problem.   If all of the culvert 
barrels are exactly the same, then only one culvert type (Culvert ID#) should be 
entered.  The number of barrels is an input parameter in the culvert data.  If the 
user has culverts that are different in shape, size, elevation, or loss coefficients, 
then additional culverts types (Culvert ID#'s) must be added for each culvert type. 

 

 
Figure 3.  Culvert Data Editor 

 
 To add an additional culvert type you can either use the Add or Copy buttons.  
The Add button increments the culvert ID# and clears the culvert editor.  The 
Copy button increments the culvert ID# and makes a copy of the original culvert 
data.  Once a copy is made of a culvert, the user can change any of the existing 
culvert information.  Culverts can be deleted by pressing the Delete button. 
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Solution Criteria - This field allows the user to have control over which solution 
criteria (Inlet or outlet control) is used as the final answer.  The default is to let 
the program use the answer that produces the greater upstream energy.  In 
general, the program should be left in this mode.  The option to force the 
program to use either the Inlet control answer or the Outlet control answer is 
available for added flexibility.  This option should only be used when the user 
thinks that either the inlet control or outlet control answer is incorrect or not 
appropriate for the problem that it is being applied to.   

 
Rename - This button allows the user to put in their own identifier for each of the 
culvert types.  By default the culvert types will be labeled "Culvert #1," "Culvert 
#2," and so on.  The user can enter up to twelve characters for each culvert type. 
 
Shape - The shape selection box allows the user to select from one of the nine 
available shapes.  This selection is accomplished by pressing the down arrow on 
the side of the box, then selecting one of the nine available shapes. 
 
Span - The span field is used to define the maximum width inside of the culvert.  
The span is left blank for circular culverts. 
 
Rise - The rise field describes the maximum height inside of the culvert. 
 
Chart # - This field is used to select the Federal Highway Administration Chart 
number that corresponds to the type and shape of culvert being modeled.  Once 
the user has selected a culvert shape, the corresponding FHWA chart numbers 
will show up in the chart # selection box.  More information on FHWA chart 
numbers can be found in the Hydraulics Reference manual. 
 
Scale# - This field is used to select the Federal Highway Administration Scale 
number that corresponds to the type of culvert entrance.  Once the user has 
selected a culvert shape and chart #, the corresponding FHWA scale numbers 
will show up in the scale selection box.  More information on FHWA scale 
numbers can be found in the Hydraulics Reference manual. 
 
Distance to Upstream XS - This field is used to locate the culvert in space, 
relative to the two cross sections that bound the culvert crossing.  The user 
should enter the distance between the upstream cross section and the upstream 
end of the culvert barrel. 
 
Culvert Length - The culvert length field describes the length of the culvert along 
the centerline of the barrel. 
 
Entrance Loss Coefficient - The coefficient entered in this field will be multiplied 
by the velocity head inside of the culvert at the upstream end.  This value 
represents the amount of energy loss that occurs as flow transitions from the 
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upstream cross section to inside the culvert barrel.  This coefficient is used in the 
outlet control computations. 
 
Exit Loss Coefficient - The coefficient entered in this field will be multiplied by the 
change in velocity head from inside the culvert to outside the culvert at the 
downstream end.  This value represents the energy loss that occurs as water 
exits the culvert.  This coefficient is used in the outlet control computations. 
 
Manning’s n for Top - The n-value fields are used for entering the Manning's n 
values of the culvert barrel.  This version of HEC-RAS allows the user to enter a 
separate n value for the top (which includes top and sides) of the culvert, as well 
as for the bottom.  If the culvert has the same roughness for the top and bottom, 
the user can enter the value for the top.  The Manning’s n value for the bottom 
will automatically be copied from the top field. 
 
Manning’s n for Bottom – This field is used to enter a Manning’s n value for the 
bottom of the culvert.  This n value will be used up to a user specified depth 
inside of the culvert.  When the water surface gets higher than that depth, a 
composite Manning’s n value is computed based on the bottom and top n values 
and their corresponding wetted perimeters. 
 
Depth to use Bottom n – This field is used to specify the depth that the “Bottom n 
value” is applied inside of the culvert.  The surface of the culvert below this depth 
is given the n value for the bottom of the culvert, while the surface of the culvert 
above this depth is given the n value for the top of the culvert. 
 
Depth Blocked – This field is used to block off a portion of the bottom of the 
culvert.  When a value is entered into this field, the culvert is completely blocked 
up to the depth specified.  This blocked out area persists the whole way through 
the culvert. 
 
Upstream Invert Elevation - This field is used to describe the elevation of the 
culvert invert at the upstream end.   
 
Downstream Invert Elevation - This field is used to describe the elevation of the 
culvert invert at the downstream end. 
 
# Identical Barrels - This field is used to display the number of identical barrels.  
The number of identical barrels is limited to 25.  To enter more than one identical 
barrel, the user must provide different centerline stationing information for each 
barrel.  As the centerline stationing information is added, the number of identical 
barrels will automatically change to reflect the number of centerline stations.  The 
user does not enter anything into this field, it is just used to display the number of 
identical barrels 
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Centerline Stations - This table is used to enter the stationing of each culvert 
barrel.  Centerline stations must be provided for both the upstream and 
downstream side of each culvert barrel. 

 
Once all of the culvert information is entered, the user should press the OK 
button at the bottom of the window.  Pressing the OK button tells the interface to 
accept the data and close the window.  Once the culvert editor is closed, the 
graphic of the culvert will appear on the Bridge/Culvert Data editor window.  An 
example culvert is shown in Figure 4.  Note!  The data are not saved to the 
hard disk at this point.  Geometric data can only be saved from the File menu 
on the Geometric Data window. 

 
 

 
Figure 4.  Bridge/Culvert Data Editor With Example Culvert 
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III.  Culvert Example 
 

In order to gain a better understanding of how to enter culvert data, an example 
culvert problem will be demonstrated in class.  The following notes parallel what 
will be demonstrated in class. 
 
For this example, the Multiple Pipe data set will be used to demonstrate the entry 
of culvert data.  This data set has five cross sections.  The schematic diagram for 
this data set is shown in Figure 5. 
 

 
Figure 5.  Schematic of Multiple Pipe Data Set 

 
The steps in entering the culvert data are as follows: 
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A. Press the Bridge/Culvert Data Editor Button.  Pressing this button will 
bring up the bridge and culvert data editor as shown in Figure 6 (except it 
will be blank at first). 

 
B. Select Add a Bridge and/or Culvert from the Options menu.  When this 

is selected, the program will ask for the river station of the culvert 
crossing; enter a value of 2.5.  This will place the bridge between cross 
sections 2 and 3.  Figure 6 shows the cross sections when they first come 
up in the editor. 

 
C. Next enter the road embankment information by pressing the 

Deck/Roadway button on the editor.  Figure 7 shows the editor along with 
the data to be entered for this problem. 

 

 
Figure 6.  Bridge and Culvert Data Editor 
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Figure 7.  Deck/Roadway editor With Example Data. 

 
 

Once the data are entered, press the OK button.  The editor will close and the 
deck/roadway information will be added to the cross sections plotted on the 
bridge/culvert data editor.  Figure 8 shows the editor with the road embankment 
data added. 
 
D. The next step is to enter the culvert data.  This is accomplished by 
pressing the Culvert button on the bridge/culvert editor.  Figure 9 shows the 
culvert data editor with the data for this example. 
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Figure 9.  Culvert Data Editor With Example Data 

 
As shown in Figure 9, the data for this example consists of a circular culvert with 
twin barrels.  Each barrel is 6.0 feet in diameter.  The culverts are concrete with 
square edge head walls at the entrance (chart #1 and scale #1).  The length of 
the culvert is 50 feet, the selected Manning’s n value is 0.013, and the entrance 
and exit loss coefficients are 0.5 and 1.0 respectively.  

 
Once all of the culvert data are entered, press the OK button.  The bridge/culvert 
data editor will be updated to include the culvert information in the cross section 
graphics.  Figure 10 shows what the bridge/culvert data editor will look like once 
the culvert data is entered. 
 
Next we have to add ineffective flow areas. 
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Ineffective flow areas are essential to calculate conveyance and contraction and 
expansion in a one-dimensional model, particularly surrounding a multi-
dimensional structure like a culvert. 
 
Ineffective flow areas have to be added to the upstream and downstream cross 
sections (not the structure itself).  So HEC-RAS provides buttons that 
automatically open the upstream and downstream cross sections. 
 

 
 

These buttons open those cross sections with the ineffective flow area editor 
already open. 
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E. The next step is to close the bridge/culvert data editor.  This can be done 
by selecting the Exit option from the File menu of the editor.  Once this 
option is selected, the editor will close and control will go back to the 
geometric data window.  The schematic of the river system will be updated 
to include the culvert information.  Figure 11 shows the new river system 
schematic with the culvert data entered. 
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Figure 10.  Bridge/Culvert Data Editor With Culvert Data 
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Figure 11.  River System Schematic With Culvert Data 

 
 

F. The last step is to save the geometric data by selecting Save Geometric 
Data from the File menu of the geometric data editor. 

 
After the culvert data are saved, you can perform the water surface profile 
calculations.  Once the calculations are finished, you can begin to review the 
results.   
 
An example cross section plot of the upstream end of the culvert is shown in 
Figure 12.  This plot shows the water surface and energy gradeline for three 
profiles that were computed.  Figure 13 shows the computed water surface 
profiles for this example, and Figure 14 shows the X-Y-Z perspective plot for the 
entire reach with the culvert. 
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Figure 12.  Example Cross Section Plot of Culvert 

 

 
Figure 13.  Example Profile Plot With Culvert Data 
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Figure 14.  X-Y-Z Perspective Plot With Culvert Data 

 
 

In addition to the graphical plots, there are several types of tables that contain 
information about and around the culvert.  An example of the Four Cross 
Section Culvert table is shown in Figure 15.  Figure 16 shows the Culvert Only 
table, while Figure 17 shows a Culvert cross section specific table. 
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Figure 15.  Example of the Four Cross Section Culvert Table 

 

 
Figure 16.  Example of the Culvert Only Profile Table 
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Figure 17.  Example of the Culvert Cross Section Specific Table 

 
 


